
User Manual for
DST GPS

and
SeaStar
Graphic Supporting Software

Vatnagardar 14
104 Reykjavík
Iceland
Tel: +354 533 6060
Fax: +354 533 6069
star-oddi@star-oddi.com
www.star-oddi.com



User Manual SeaStar Graphic Supporting Software

@2010 Star-Oddi. All Rights Reserved Page 2



User Manual SeaStar Graphic Supporting Software

@2010 Star-Oddi. All Rights Reserved Page 3

Table of Contents
1. Introduction ................................................................................................7
2. Program Installation...................................................................................9

2.1 Install ........................................................................................................9
2.2 Uninstall ....................................................................................................9

3. Preparation ...............................................................................................11
3.1 Select Recorder Type .............................................................................11
3.2 Configuration of the Communication Port ...............................................12
3.3 Using the USB Serial Converter .............................................................13

4. Communication Box.................................................................................15
4.1 Communication Box................................................................................15
4.2 Connection Point ....................................................................................16
4.3 COM Connection ....................................................................................17
4.4 Connection Wizard .................................................................................17

5. Using DST GPS - Tutorial ........................................................................19
5.1 DST GPS Set Up ....................................................................................19

Step 1 - Start Program ...................................................................................19
Step 2 - Connect ............................................................................................19
Step 3 - Connect to the Recorder ..................................................................19
Step 4 - Set New Measurement Parameters..................................................20
Step 5 - Start a New Measurement Sequence...............................................22
Step 6 - Retrieve Data ...................................................................................25
Step 7 - Disconnect........................................................................................25
Step 8 - View Data .........................................................................................25

6. View Data ..................................................................................................27
6.1 Open Data ..............................................................................................27

Import.............................................................................................................28
Buttons...........................................................................................................28
Using the Mouse ............................................................................................30

6.2 The View Menu.......................................................................................31
Data Trend and Table ....................................................................................31
Recorder Information (RIT) ............................................................................31
Recorder Calibration Information (RCI)..........................................................31
Recorder Download Information (RDT)..........................................................31
Viewing Text Files..........................................................................................31
SNMS LOG File .............................................................................................32
Measurement Data ........................................................................................33
SeaStar Log...................................................................................................36

6.3 Opening Data in Excel ............................................................................36
Joined Date and Time....................................................................................36

7. Printing......................................................................................................39
7.1 Orientation ..............................................................................................39
7.2 Margins ...................................................................................................39
7.3 Move .......................................................................................................40
7.4 Details.....................................................................................................40

8. Settings .....................................................................................................41
8.1 Directories...............................................................................................41

Default SeaStar Path Structure......................................................................42



User Manual SeaStar Graphic Supporting Software

@2010 Star-Oddi. All Rights Reserved Page 4

User Defined Paths........................................................................................42
Browse First in User Directory .......................................................................42
Create Recorder Directories ..........................................................................42

8.2 Preferences ............................................................................................42
Units...............................................................................................................42
Select Units....................................................................................................43

8.3 Data File Format .....................................................................................43
Date Format ...................................................................................................44
Date Separation .............................................................................................44
Time Separation.............................................................................................44
Field Separation.............................................................................................45
Date and Time Column Definition ..................................................................45
Select Decimal Point......................................................................................45
Measurement Interval ....................................................................................45

8.4 Connection..............................................................................................46
Perform CRC Test when Retrieving RID........................................................46
Check Data Echo in SNMS............................................................................46
Automatic Data Retrieval upon Connection ...................................................47

8.5 Retrieve Data..........................................................................................47
Retrieve Number of Data ...............................................................................47

8.6 ReConversion .........................................................................................48
8.7 Out Of Range..........................................................................................49

Decimal Values ..............................................................................................50
Unit Values.....................................................................................................50

8.8 Time Synchronize Data (TSD) ................................................................51
8.9 Rate Of Change (ROC)...........................................................................52
8.10 Chart ...................................................................................................54

1. Title .........................................................................................................54
2. Time Axis ................................................................................................54
3. Value Axis...............................................................................................55

8.11 Chart Editor .........................................................................................55
1. Series......................................................................................................56
2. Chart .......................................................................................................57
3. Data ........................................................................................................61
4. Tools .......................................................................................................62
5. Export .....................................................................................................63

8.12 Timeline...............................................................................................66
8.13 Templates ...........................................................................................67

Saving a Template .........................................................................................68
Using a Template...........................................................................................69

9. Multiple Intervals ......................................................................................71
9.1 Measurement Interval .............................................................................71
9.2 Setup Mode ............................................................................................71
9.3 Number of Measurements N1-N7 ...........................................................72
9.4 GPS as Primary ......................................................................................73
9.5 Secondary Interval ..................................................................................73
9.6 After a GOOD GPS Code Perform .........................................................73
9.7 A good GPS Measurement is Defined as ...............................................73
9.8 Set STDI (Special Temp Depth Interval).................................................74



User Manual SeaStar Graphic Supporting Software

@2010 Star-Oddi. All Rights Reserved Page 5

9.9 Sequence 1-14 .......................................................................................74
9.10 Primary Receive Code Format ............................................................74

10. Reconvert Data .........................................................................................75
10.1 Data Reconversion Definition..............................................................75

Set Reconversion Measurement Sequence Start-Time .................................76
In Reconversion use Measurement Intervals from.........................................76
In Reconversion use Constants from .............................................................76
Convert Number of Data ................................................................................76
Time Linear Adjustment .................................................................................76
Out of Range Decimal Value Settings............................................................77

10.2 Temperature Definition........................................................................77
Offset Adjustment ..........................................................................................78

10.3 Pressure Definition..............................................................................78
Disable Temperature Correction in Pressure Calculation ..............................79
Pressure Offset Adjustment ...........................................................................79
Pressure Linear Adjustment...........................................................................79
Linear Estimation outside Calibration Range .................................................80
Depth Calculation...........................................................................................80

10.4 Single Spike Correction.......................................................................80
Units and Data File Format ............................................................................81
Reconvert Data ..............................................................................................81

11. Recorder Modes .......................................................................................83
11.1 PC Mode .............................................................................................83
11.2 Sleep Mode .........................................................................................83
11.3 Measurement Mode ............................................................................83

12. Memory Organization...............................................................................85
13. GPS Measurements..................................................................................87

13.1 LC combinations .................................................................................87
Codes ............................................................................................................88
Data Storage..................................................................................................88

14. Appendix ...................................................................................................91
14.1 Directories and Files............................................................................91

Directory Structure .........................................................................................91
Information Files ............................................................................................91
Files Locations ...............................................................................................92
Browsing for a Recorder ................................................................................92
Recorder Related Files ..................................................................................93
Measurement Related Files ...........................................................................93
Data Files.......................................................................................................94
Data Header...................................................................................................94

14.2 Log Codes...........................................................................................95



User Manual SeaStar Graphic Supporting Software

@2010 Star-Oddi. All Rights Reserved Page 6



User Manual SeaStar Graphic Supporting Software

@2010 Star-Oddi. All Rights Reserved Page 7

1.Introduction

SeaStar is supporting software for the DST GPS Data Storage Tag.
SeaStar can run under Win98, Win 2000, WinXP, WinNT and Vista. This
manual takes you step-by-step through the program installation, hardware
connections and use of the SeaStar Program.

This manual guides the users of DST GPS through the operation of the
recorder. Setting the operating parameters as well as data retrieval
requires access to a PC computer with a standard RS-232C serial
interface or USB.

This version of SeaStar does not include Help files, so the Contents and
Index command in the Help menu is inactive. The users of SeaStar will
receive free updates of the software. Upgrades of SeaStar are available
for free download at http://www.star-oddi.com/Online-Support/Software-
updates/.
Please note that the downloaded file has to be installed into the existing
SeaStar folder. The update alone is not a complete program and therefore
will not work like that. Follow the instructions on the update website for
correct installation.

DST GPS is a compact microprocessor-controlled temperature and
depth recorder with electronics housed in a waterproof housing.

The temperature and pressure sensors are located in the cup as shown
on the diagram below.

Figure 1.1 DST Sensors

Pressure (depth) sensor

Temperature sensor

http://www.star-oddi.com/Online-Support/Software-updates/
http://www.star-oddi.com/Online-Support/Software-updates/
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It is extremely important that the area where the sensors are located is
kept free from other materials to be pressed against it. This is to allow free
flow of water/liquid to the sensors.
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2.Program Installation

This chapter describes how to install and uninstall the SeaStar software
on your PC computer.

2.1 Install

The installation program is on the SeaStar CD. Insert the CD into your
compact disc drive. To install the program, follow the automatic
InstallShield Wizard.

Follow the instructions on the screen. You will be prompted for a directory
name for your SeaStar program.

2.2 Uninstall

To uninstall the program, do the following:

1. Click on the Start button in Windows.
2. Go to Settings and Control Panel.
3. Choose Add/Remove Programs.
4. Choose SeaStar and click on Change/Remove, and ‘Yes to all’.
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3.Preparation

This chapter describes preparations that should be carried out before
connecting to the recorder.

Start SeaStar and the following window appears.

Figure 3.1 SeaStar Main Window

3.1 Select Recorder Type

SeaStar is compatible with other Star-Oddi instruments. A recorder type
must be selected before connecting to the recorder. The default setting in
the software is set to Starmon mini as a recorder type. Change the
recorder type to DST GPS by doing the following:

1. Choose the File menu and the New Recorder Type command.
2. Select DST GPS as a recorder type.
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Figure 3.2 Select DST GPS as Recorder Type

Before connecting to the recorder, it is important that the clock on the PC
computer is correct. This is important since the recorder automatically
downloads the PC clock settings.

3.2 Configuration of the Communication Port

It is necessary to define which serial port on your PC computer you will
use for connecting the Communication Box. This is done in the following
way:

1. Choose the Communication command in the Settings menu.
The Communication definition dialog box appears.

2. Select a serial port for communications.
3. Choose the OK button.

Figure 3.3 Communication Port Configuration
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To check which communication ports are available on your computer,
open your Device Manager. On Windows XP you can do it following way:
Control panel > system > hardware > device manager.
Under Ports you can view all available ports. Make sure that the port you
are intending to use is enabled: right-click on the appropriate port and
select properties. Under ‘Device usage’ it should state ‘use this device
(enable)’.

Figure 3.4 Enable Communication Port

3.3 Using the USB Serial Converter

If you are using the USB serial converter you will need to install the driver
first that comes on the provided CD. Please, read the ‚Quick Installation
Guide‘ booklet to get further instruction on how to proceed.

After you plug in the USB cable you will see a new communication port in
your device manager, called ‚Prolific USB-to-Serial Comm Port‘. Make
sure that the port is enabled and select the appropriate port in SeaStar.
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Figure 3.5 USB Communication Port in Device Manager
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4.Communication Box

This chapter provides details concerning the Communication Box and
how to place recorder in the box prior to connection.

4.1 Communication Box

The DST Communication Box is a PC-RS-232C compatible
communication interface, specially designed to communicate with DST
recorders wirelessly via RF (radio frequency). A USB serial converter
cable can optionally be used with the Communication Box.

The Communication Box has three diodes:

1. Red – shows that power is fed from the power supply to the
Communication Box.

2. Yellow – shows that SeaStar has made connection with the box,
the appropriate DST has been selected as a recorder type and that
correct COM port has been selected.

3. Green – shows that recorder is in correct position for seeking
connection.

Connect the serial cable between the serial port of the computer and the
Communication Box. Plug the power supply connection to a power-
socket. The voltage from the power supply should be set to 9V, although
there is no damage to use up to 20V. Before inserting the power plug into
the box, it is important to note that the polarity should be:

The polarity is usually shown where the arrows meet on the power plug,
and the power supply. After the power supply has been connected to the
Communication Box, the red light should be on. After SeaStar has been
started, the yellow light should be on (if correct COM port is selected).

The box will power the recorder while communicating with the PC. In
case the battery is dead, the PC and interface are still able to connect to
the recorder and retrieve data.

-(O+ (minus on the outside and the plus on the inside)



User Manual SeaStar Graphic Supporting Software

@2010 Star-Oddi. All Rights Reserved Page 16

4.2 Connection Point

In order to get the green light, the red and the yellow light must be on.
The recorder is inserted into the hole of the box as shown in the figure
below:

Figure 4.1 Inserting Recorder into the Communication Box

If the recorder has been recording in the waters, then please wipe it dry
before inserting it into the box. The spherical end of the recorder faces
down and flat end faces up. Recorder is rotated until the green light
illuminates.
When green light is on, communication can be established with the
software. For best connection conditions, recorder is placed in the middle
of the area where the green light is on.
For our latest products we have added a mark on both the housing and
the Communication Box to help finding the right position. Simply turn the
logger until the small grey mark on top of the sensor meets the marking
that is drilled into the surface of the Communication Box.
If the recorder fails to connect, please refer to the Troubleshooter.

Communication Box

DST GPS
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4.3 COM Connection

Figure 4.2 Communication Definition

Choose Settings-Communication-Serial Ports to display available
ports. Com ports up to COM255 can be selected.

4.4 Connection Wizard

Figure 4.3 Connection Wizard

Choose Help-Wizards-Connection to enter the connection wizard. The
wizard goes through available ports and activates them one at a time and
asks the user to confirm that the communication box displays an orange
light.
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5.Using DST GPS - Tutorial

This chapter guides users in 8 quick steps through the process of utilizing
SeaStar to set up DST GPS prior to recording and data retrieval.

5.1 DST GPS Set Up

Step 1 - Start Program
Start SeaStar. Remember to carry out the software preparation outlined
in chapter 3.

Step 2 - Connect
Connect the Communication Box as described in chapter 4. Insert DST
GPS into the hole in the box, and twist the recorder until the green light
illuminates on the box.

Step 3 - Connect to the Recorder
Choose the Recorder menu and the Connect command. A window
appears with information on the recorder’s mode, example:

Figure 5.1 Connecting to the Recorder

Press OK. The Recorder is now on-line, as indicated at the bottom of the
SeaStar window.

Connection Time Registration
Each time SeaStar connects to a Recorder, the PC time and recorder
time is registered to a binary file, with a CLK extension. This information is
also saved to a text file with the extension CCT.
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Another text file is created with the extension CCD, containing various
information, for example on previous connection and time comparisons,
depending on the status of recorder.
If a previous CCT file exists and the recorder was in sleep or slumber
mode, a PC vs. recorder clock comparison is calculated, indicating
difference in seconds and ppm.
If the recorder was in measurement mode, then a drift calculation is
performed, based upon PC-time comparison to the recorder’s clock and
measurement sequence.
The RIT file contains partly the same information as the CCD file.
Upon retrieving date from a recorder and converting the data, the last
measurement retrieved time and the next scheduled measurement time is
compared to the PC time. The results are added to the CCD file and the
MIT file.
Note: If the retrieved number of data does not match the last measured
number of data, erroneous results are to be expected.

Step 4 - Set New Measurement Parameters
(If the recorder has already been set up to record data and you want to
retrieve data, go directly to step 6). Choose the Edit menu and the New
Measurement Sequence Definition command. The window shown on
Figure 5.2 appears.

Select the start time of recordings (date-month-year, hours-minutes).
Set the sampling interval (hours-minutes-seconds).

If the user wants to program several recorders with the same sampling
interval and start time, it is recommended to select Multi mode. By
choosing Multi mode, the settings are fixed; giving each recorder
connected to thereafter, the same settings. The recorders connected to
following the first recorder, automatically get the same settings as the first
recorder. This saves time in the programming process.
The three buttons Use Template, Use Sequence, and Previous are not
commonly used, but can be handy when wanting to use a previously
programmed sequence. To read more about templates see ‘Templates’ in
chapter 8.

Set primary measurement interval time (hours-minutes-seconds). If the
GPS is enabled as a primary measurement, the GPS acoustic listening
will be according to the defined interval time. Temperature and depth then
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becomes secondary and needs to be defined. The Temp-Depth interval is
defined as how often the tag should record the Temp-Depth along with
GPS listening. For example, if the interval is set as 6, then the tag will
record Temp-Depth every sixth time when GPS/acoustic code listening is
performed (once every 30 min. as in the example in fig. 5.2). If the GPS is
not enabled as a primary measurement then Temp-Depth becomes
primary.

Figure 5.2 Measurement sequence definition
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Special Temp Depth Interval (STDI) needs to be defined. The number of
measurements taken should also be defined. This gives an option to shift
into a different temperature and depth recording interval after receiving a
good GPS code.

At each GPS listening, the tag tries to receive six codes, and afterwards
defines the quality of the codes. A GOOD GPS code can be defined as
receiving the same code once with all Sync bits and Parity OK, twice or
three times (SPOK=Sync-Parity OK). If for example two of same code is
received in a row, the probability of erroneously decoded position is 1
against 10000 (Pe<1e-4).

The special TD interval can be defined as to execute ‘never’, ‘only once’ or
‘always’ upon a good GPS code recording. Also, after a good GPS
measurement, the tag can be programmed to ‘continue as before, ‘swap
primary and secondary’ or ‘cancel further GPS measurements’.

Primary Receive Code Format should be synchronized with how the FPS
is programmed. Global is only used when the boat crosses the
hemisphere, FPS-1 (610 m resolution) if the boat crosses a quadrant,
FPS-2 (70 m resolution) when boat is within the same quadrant. If the
FPS is at fixed location the FPS-ID should be enabled.

For Initial Position the longitude and latitude at the location should be
defined.

After the settings have been selected, press the OK button. For
programming more than one sampling interval within the measurement
sequence, please refer to chapter 9 ‘Multiple Intervals’.

Step 5 - Start a New Measurement Sequence
To set the recorder in Measurement Mode (start recording), choose the
Recorder menu and Start New Measurement Sequence command.
A window appears on the screen in order to verify the settings to be
downloaded into the recorder, example:
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Figure 5.3 Start New Measurement Sequence

Press OK and the recorder will be in Measurement Mode.

NMS Calculation
Upon setting up a NMS the estimated measurement sequence is
calculated and memory and battery energy usage predicted. The results
are written to a text file, bearing the recorder name with a NMS extension.
If a recorder has not been selected then the file bears the recorder type
name, still the NMS extension.
The file is placed in the SeaStar\NMS directory.
An example of the *.NMS file is shown in fig. 5.4.

Figure 5.4 Results from NMS Calculation
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When starting the recorder in a NMS, the *.RDT file shows the sequence
settings, plus information on the sequence time duration and battery
usage (same as in the *NMS file).
When using DST GPS recorders, the energy calculations are based on
an estimation of GOOD GPS measurements. The user sets the number of
these GPS measurements in the Settings\Preferences\NMS time and
energy calc.\ menu. (see figure 5.5).

Figure 5.5 Set Number of GPS Measurements

When using DST GPS recorders, the energy calculations are based on
an estimation of the in-water and out-of-water ratio. The user sets this
ratio in the Settings\Preferences\NMS time and energy calc.\ menu (see
figure 5.6).
Time on deck/land means: Time out-of-the-water as a percentage of total
measurement time.

Figure 5.6 Set the time (in % of total measurement time) which the recorder is
estimated to be out of the water
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Step 6 - Retrieve Data
Choose the Recorder menu and the Retrieve Data command. Data will
be uploaded from the recorder and presented in graphical and tabular
form. With default settings, SeaStar automatically creates a sub-directory
in the Seastar directory, named DST GPS. In the DST GPS directory, a
directory named after the recorder’s serial number (Gnnnn) is created. All
files related to the recorder are automatically saved in the serial number
directory. The default data directory can be viewed in the Settings menu,
and Directories. The user has the option to define a new data directory
path if desired.

The data is retrieved in a non-destructive manner. This means that you
can repeatedly read the data without erasing it from the memory. Each
time data is retrieved, a new file will automatically be created. The name of
the data file consists of the measurement sequence number and the serial
number of the recorder. The recorder cannot be loaded with new settings
if it contains data that has not been retrieved. This is a safety feature
which prevents data from being accidentally lost. New recordings
overwrite previous recordings that have been retrieved.

Step 7 - Disconnect
After the recorder has been set up for measuring, it should be removed
from the Communication Box. If the recorder is not put in measurement
mode, it will automatically go into sleep mode when removed from the
box.
If you simply remove the tag SeaStar will still have the recorder in on-line
mode in the program and won’t allow selecting another recorder or using
certain options. Select Recorder > Disconnect to go into off-line mode.

Step 8 - View Data
If data is retrieved from the recorder, a new file will automatically be
created and opened in graphical and tabular form. To open existing data
files on the computer, choose the File menu, Select Recorder command,
and then the Select Measurement command. When a data file has been
opened, a new window appears with the data shown as a chart and a
table. The next chapter will describe in detail how to view and process
data.
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6.View Data

This chapter describes how to open a data file and the options available
in SeaStar for viewing the data.

6.1 Open Data

To open an existing data file that has already been retrieved, do the
following:

1. Choose the File menu and the Select Recorder command. When
a recorder has been selected, its serial number will be displayed in
the blue top bar of the software.

2. Select the data file by choosing the File menu and the Select
Measurement command.

The name of the data file consists of the measurement sequence number
(number of times the recorder has been set up to measure) plus the serial
number of the recorder. The ‘Measurement sequence no.’ can also be
seen at the bottom in the SeaStar window. When the data file (.mid) has
been selected, the chart and data tables are opened. The following figure
shows a chart and data table which have been opened:

Figure 6.1 Chart and Data Tables of an open File
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Import
Data files from other recorders than DST can be imported into SeaStar
and viewed as charts and tables. The imported file must be a text file with
the extension DAT, and with SeaStar’s conventional DAT file structure.
See more about data files and headers in Appendix II.

Buttons
When the chart is opened, buttons related to the chart are displayed.

Active Series List
This button can be useful when working with a multi-sensor recorder, in
order to select which parameters to display in the chart. For example,
when working with a chart displaying temperature and depth recordings,
the user can hide the depth or the temperature line in the graph.

Horizontal/Vertical Gridlines
These two buttons give the option of hiding/displaying the
horizontal/vertical gridlines in the chart.

Data Point Marker
This button gives the option of displaying/hiding data points in the chart.

Histogram
The graph can be shown as histogram, showing various data statistics.

Save Window Data
Retrieved data is automatically saved, but if changes are made with the
graph, for example with the time scale, the save button enables the user
to save the graph (as a DAT file).
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Print
The chart can be printed. Please see chapter 7 for more details.

Data Zoom
This button adjusts the axis in order to display all data within the zoomed
timeline.

Chart Edit
By clicking this button, the following window appears:

Figure 6.2 Editing Chart

This button gives several options regarding the look of the graph. The axis
can be defined (max and min), titles and legend can be set visible. Under
‘Panel’ the color of background, borders and gradient can be selected.
Under ‘Walls - Back’ the colors and gradient of the graph itself can be
selected. The ‘Visible’ option must be enabled to activate the features.
The graph can be exported in formats as jpg, gif, bitmap, metafile, pdf,
htm and svg.
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Templates
If the changes have been made to the graph under ‘Chart Edit’, it is
possible to save that template. It is also possible to load a previously
saved template.

Hide/Show table
The data table can be either displayed or hidden using this option.

Using the Mouse

Minimum and Maximum Values
Click once on either line in the chart, and the maximum and minimum
values for that parameter are now shown. A straight vertical line should be
visible in the graph (to the left). By clicking on this line and holding the left
button on your mouse down, the line can be dragged through the chart
and the data table will scroll along with the position of the line.

Zoom
The chart can be zoomed in on by holding down the left button of the
mouse, and using the cursor to create a box to the right, around the
desired area to zoom in on.

Scroll the Chart
The chart can be scrolled upward, downwards and to the sides, by
holding down the right button of the mouse and moving the cursor in the
desired direction.

Go back to initial view
To go back to the initial view of the chart, simply hold down the left button
of the mouse and make a box to the left with the cursor. The position of
the box on the chart is irrelevant.

Change the Axis
By double clicking on the X and Y-axis, the measurement time and
temperature/depth range can be changed.

Change the Title
To change the title of the chart, double click on the title of the chart
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6.2 The View Menu

When a recorder has been selected, the files in the View menu can be
opened.

Data Trend and Table
This view is automatically selected when data is retrieved or a data file is
opened. If the chart is closed, but a recorder has been selected, this
command can be selected to view the chart. The software will open the
latest chart that was viewed for that recorder.

Recorder Information (RIT)
This is a text file containing basic information about the recorder, serial
number, production date, estimated battery life etc.

Recorder Calibration Information (RCI)
This text file contains information about the calibration constants of the
recorder, calibration range of the parameters. The range is both showed
as decimal values (DV) and unit values (UV). The survival depth of the
recorder is also shown.

Recorder Download Information (RDT)
This text file contains information about the measurement sequence that
was last downloaded into the recorder, including the start time, sampling
interval and the measurement sequence number.

Viewing Text Files
Under <View\Text files> the user can select a text file, via a file browser,
for viewing.
This option is meant to give the (advanced) user a chance to view files
that are not directly supported for viewing in SeaStar, but are a part of the
SeaStar documentation system.
The files that the file browser accepts must have the following extensions:

 TXT
Frequently, users copy SeaStar data to text processors and
spreadsheets, like Word and Excel, and later save the data as TXT
files for viewing in other applications.
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 INI
There are a number of INI files that SeaStar uses for store settings.
These files are described in the Appendix under ‘Information files’.
The latest members in the INI files family are the Template files.

 DAD
This is the original data file. It contains the raw data (in Ascii format)
retrieved from recorder. The DAD together with the MID are
converted to the DAT file.
A word of warning: The DAD file should never be tempered with, as
that might give cause to erroneous data conversion.

 CCT
Every time SeaStar connects to a recorder, the PC time and the
recorder’s clock data are stored in a <recorder name>.CCT file.

 CCD
Every time SeaStar connects to a recorder, the PC time and the
recorder’s time are compared to the last CCT, if found, and stored
in <recorder name>.CCD file, <measurement sequence
name>.CCD.

 NMS
Upon completion of a NMS editing session, estimation of memory
and battery usage is calculated and the results placed in a NMS
file, which is then displayed to the user.

SNMS LOG File
To improve the “Start New Measurement Sequence”, SNMS,
indication/registration of success or failure, a log file for each recorder
type is placed in the SeaStar directory.
The log file name, for example for DST GPS, is DSTG.LOG, i.e. the same
naming convention as for the type INI files.

Each time a SNMS is performed then the appropriate LOG file is
updated.
The LOG file can be viewed via “View\SNMS Log file (LOG)” (see figure
6.3).

In addition to the LOG file, if an error occurs during the SNMS, the MDD
file is created as a text file, with a description of what went wrong. This
MDD file is displayed as a clear message for the user:
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Figure 6.3 The MDD SMNS Error Message

Usually the MDD file is a binary file, and the MDT is created from the
MDD. If the SNMS is repeated successfully the MDD file is overwritten
and the MDT file created.

Measurement Data

Measurement Download Definition (MDT)
This text file contains information on data downloaded into the recorder
for the measurement file being viewed, including the start time and
sampling interval.

Measurement Information (MIT)
This text file contains information concerning the measurement upload
time, start date, start time and number of measurements in the
measurement data file.

Conversion Information (CIT)
This text file contains conversion information on the units and the data file
format.

Statistics in CIT
The CIT has been enhanced with more detailed information on the
converted data.

As can been seen in figure 6.4, the statistical data, that have been
tabulated, are split into two sections, the Unit values statistics and the
Decimal value statistics. Values are given for each parameter. The file can
be viewed under ‘View\Measurement Data\Conversion Information (CIT)’.
A one line description/comment is available for the user to fill out in the
Reconvert data menu. This description is placed in line two of the CIT file.
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Figure 6.4 Statistics in CIT

Out of Range (OOR)
This text file lists all the measurements that were outside decimal value
calibration range, as well as the unit value range. If correction has been
performed according to the user definition, then the corrected values are
shown. See more about in chapter 8.7 Out of Range.

Binary Data (DAB)
This file contains raw data of the measurements in the data file.
Calibration files are not calculated into the data.

View DAB Files as Trend
When converting the DAD -> DAT the DAB file is created simultaneously.
The DAB shows the recorder’s native data, i.e. decimal values in the
range 0-4095. These values originate from the recorders 12 bit ADC
(Analog to Digital Converter).
It can be of interest to view the data in its native form, for example to spot
saturation/out of range intervals.

The DAB can be viewed graphically as a trend via:

‘View\Data Trend and Table\Decimal (Binary) data (DAB)’
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Figure 6.5 DAB Trended

SeaStar cannot view older DAB files, and will inform the user to that
effect, if an attempt to view an older DAB file is performed. By
reconverting the data, a viewable file is produced.

Converted Data (DAT)
This is the text file for the converted data. The DAT file as well as the
other text files can be opened in other programs (Excel, Notepad, Word
etc.).

Time Synchrone Data (TSD) and Rate of Change (ROC)
If the TSD and/or ROC file creation has been enabled under the Settings
menu, then it’s possible to view these files.

You can find more in chapter 8.8 TSD and chapter 8.9 ROC.

Log and GPS Codes (GPS)
This is the text file for the converted GPS data. The file is divided into 12
columns, 1-6 lines for each GPS measurement, depending on the
measurement result. The columns are as follows:
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MesNr: The temperature and depth measurement number
GPSNr: The GPS measurement number
Date: Measurement date
Time: Measurement time
LC: Log Code
Sapl: Signal Amplitude. Start-pulse Analog value (0-4095)
HR1: Hit Rate on the first Sync-pulse (0-255)
HRS: Hit Rate on the Stop-pulse (0-255)
GPS-dec: The GPS measurement result in DECIMAL format
GPS-hex: The GPS measurement result in HEX format
POSITION: The GPS calculated POSITION
EC: Error Code

For further description of the GPS measurements and Log Codes see
chapter 13 and Appendix.

SeaStar Log
SeaStar stores events in the file <SeaStar.log>. The events are:

 Recorder Connected
 Retrieving data from a recorder
 Uploading a measurement sequence to a recorder
 Recorder disconnected.

This file can be opened in SeaStar under <View/SeaStar Log> or by
opening it with a text editor.

6.3 Opening Data in Excel

When retrieving data, the SeaStar software automatically creates a text
file with the data, called *.DAT. This text file can be opened in Excel and in
other programs.

Joined Date and Time
Under the ‘Settings’ menu, ‘Preferences – Data File Format’, the default
factory settings is set to ‘joined date and time’. If this option is not
disabled, the following is performed, for opening data in Excel:

1. Excel is started.
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2. The *.dat file is found from ‘File/Open’.
3. Excel comes up with the ‘Text import wizard’. This is a three step

process:
a. No changes should be made in first step, so press the next

button.
b. ‘Text qualifier’ should be set as ‘None’.Press the next button.
c. Column 2, that is date and time, is set as ‘Text’. Press the

finish button.
4. You can now create the graph with columns B, C and D.



User Manual SeaStar Graphic Supporting Software

@2010 Star-Oddi. All Rights Reserved Page 38



User Manual SeaStar Graphic Supporting Software

@2010 Star-Oddi. All Rights Reserved Page 39

7.Printing

All charts and text files can be printed from the SeaStar software.
Choose the File menu and the Print command. If a chart is in the active
window, the following dialog box appears:

Figure 7.1 Print Dialog Box

7.1 Orientation

By selecting ‘Properties’, another dialog box appears, where one of the
options is to print the file in either portrait or landscape format.
When printing the GPS file, the landscape format is recommended. All
other text files are optimized for portrait printing.

7.2 Margins

By changing the margins, the chart’s length and width can be re-scaled.
The margins can be varied by either changing the numbers given for the
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left, right, top and bottom margins, or by moving the margin lines with the
mouse by pressing and holding the left button as the lines are dragged.

7.3 Move

When the cursor is located on the chart, a hand becomes visible. By
clicking on the graph and holding down the left button of the mouse, the
graph can be moved around the page to a desired position.

7.4 Details

The size of horizontal and vertical gridlines as well as the texts on the X
and Y-axis can be re-scaled by using the scroll bar. The number of
gridlines is increased when the bar is moved to the left.
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8.Settings

This chapter describes the options in the Settings menu. These settings
are automatically saved when exiting the program.

8.1 Directories

The path definition can be set as Default SeaStar path structure or User
defined paths. Choose the Settings menu and the Directories
command. A dialog box appears:

Figure 8.1 Directory Path Definition
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Default SeaStar Path Structure
By choosing DST GPS as a recorder type, SeaStar automatically creates
a ‘DST GPS’ type directory in the ‘SeaStar’ directory that was created
when the software was installed on the computer. Upon connection with
DST GPS, another directory is automatically created in the ‘DST GPS’
directory, which is named after the serial number of the recorder. All data
files and other files related to that recorder are stored in this ‘serial
number’ directory. Each DST GPS recorder has its own data directory.

User Defined Paths
If this option is selected, the User definition data directory becomes
active. The data path/directory can be defined by the user. For defining a
path on the network, the particular drive must be mapped (under
Windows Explorer) in order to browse for the drive under ‘Add data path’.

Browse First in User Directory
With default off, the user is first directed to the path where SeaStar was
installed, to look for the INI file. If this option is enabled, SeaStar will start
looking for the INI file in the user-defined directory. More information on
files and directories can be found in Appendix II.

Create Recorder Directories
This option is default on, and means that a recorder type and serial
number directory is created for every recorder connected to.

8.2 Preferences

Units
By choosing the Settings menu, the Preferences command, and Units, a
dialog box appears:
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Figure 8.2 Temperature and Pressure Unit Dialog Box

Select Units
The user defines whether degrees Celsius or Fahrenheit are used as a
unit for temperature measurements. The pressure measurements can be
displayed as pressure (bar), depth (m), fathom (fthm) or PSI. Number of
decimals for the values can be selected.

8.3 Data File Format

By choosing the Settings menu, the Preferences command, and Data
File Format, a dialog box appears:
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Figure 8.3 Data File Format Dialog Box

Date Format
The user defines whether the date should be shown as dd mm yy (day,
month, year), or mm dd yy (month, day, year).

Date Separation
The user defines whether a dot, slash or a dash should be used to
separate the date.

Time Separation
The user defines whether a colon or a dot should be used for the time
separation.
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Field Separation
For the text files created, the user defines whether a tab or a space
should be used to separate the fields.

Date and Time Column Definition
If data is to be exported to other programs, it is recommended that the
date and time be joined in one column.

Select Decimal Point
The user defines whether a comma or period is used for the values
displayed in SeaStar and for text files that are created.

Measurement Interval
The default setting in the software is set to ‘Single interval’, as most users
utilize. By choosing ‘Multiple intervals’ the software enables programming
of several different sampling intervals, enabling memory saving efficiency.
By choosing the Settings menu, the Preferences command, and then
Sampling Intervals, the following dialog box appears:

Figure 8.4 Measurement Intervals

By choosing ‘Multiple intervals’ the effects are shown in the dialog box
that appears when you choose the New Measurement Sequence
Definition command under the Edit menu. More details about multiple
intervals in chapter 9.
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8.4 Connection

Choose the Settings menu and the Connection command. A dialog box
appears:

Figure 8.5 Connect and Retrieve Data Options

Perform CRC Test when Retrieving RID
The CRC test is a safety check performed by the software when
retrieving Recorder Information Data (RID). If the CRC test is not
successfully carried out, it means that some errors have occurred in the
transfer of files or constants, between the recorder and the computer. If a
CRC test failure occurs, the user is notified. Normally, this option should
always be selected.

For example the drift in the recorder one day from start of measurements
is in hours: 24/1,000,000 x ppm, and in seconds: 24 x 60 x
60/1,000,000 x ppm.

Check Data Echo in SNMS
Normally the Check Data Echo in SNMS and updating settings in
Disconnect and Retrieve Data should be enabled (figure 8.5). In case of
communication problems using a USB serial converter the user can try to
disable this option, as it will bypass data echo checks, resulting in less
restriction on communication protocol.
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Automatic Data Retrieval upon Connection
By enabling this option, the software will automatically check for data in
the recorder upon connection. If this option is not enabled, data retrieval
is done manually by choosing the ‘File’ menu, and ‘Retrieve Data’
command.

8.5 Retrieve Data

Choose the Settings menu and the Retrieve Data command. A dialog
box appears:

Figure 8.6 Retrieve Data Options

Retrieve Number of Data
With default settings, the software retrieves the last measurement
sequence recorded. The user has the option of retrieving older data that
is still in the recorder’s memory. By choosing the User defined number
of data, the number of measurements retrieved from the recorder can be
set. When retrieving data, it is now optional to view the Data Trend after
conversion.

As the complexity of measurement intervals give incoherence in the
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calculation from measurement number to the number of data byte to
retrieve, the user has the option to define number of bytes to retrieve. Also
when not online working with measurement data, it is optional to view the
Data Trend after a Sequence Selection.
If for some reason or another it becomes necessary to retrieve data more
than once or even several times, the previous DAD and MIT files are not
overwritten before a backup has been made. The backup files are in the
same directory as the “original” or the last DAD file.
A backup number system is in use that marks the first retrieved file as
number one, the second number two etc. The number sign #, is used to
identify the backup up files.

Thus if a data file has for example the name 25M1106.DAD then the
backup file, that was the first retrieval, gets the name 1#25M1106.DAD,
and the 25M1106.MIT file that is associated with the DAD file, is backed
up as 1#25M1106.MIT.

8.6 ReConversion

Choose the Settings menu and the ReConversion command. A dialog
box appears:

Figure 8.7 Reconvert Menu

With all the options in SeaStar, the user may want to do a lot of
reconverting (<File\Reconvert Data>) on data files after defining the
preferences; changing units, data formats, OOR settings, TSD settings,
ROC settings, offset settings and converting different sections of the data
file, all of which result in numerous files. To ease the task of remembering
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settings and results and/or renaming and copying files, a backup system
of reconverted files has been implemented.

A reconvert number is now associated with each sequence. This number
is saved in the recorder’s INI file and updated each time a reconvert is
implemented. A copy is made of the DAT, CIT, DAB, OOR, TSD and the
ROC files with the reconvert number attached to the filename.

Thus if a data file is for example named 5M1024.DAT, then after the first
reconvert, a copy of the DAT is named 1-5M1024.DAT, and the same
naming convention is applied to the other files.

Each time data retrieval is performed, a subdirectory, which name is the
sequence number, is created in the data directory, where a copy of the
“original” DAT, DAB,CIT and OOR files is placed. These files have a “0-“
in their names. All the reconverted files are placed in the sequence
directory. The reconvert number system is optional, and the user can
disable it in the reconvert menu. When the reconvert number system is in
use, and when viewing trended reconverted data, the reconverted
“backup” file is displayed, thus eliminating the need to close the “last”
converted trend data window.

8.7 Out Of Range

If measurements are outside the calibrated range, they may seem
inaccurate (mainly the depth). The out of range measurements are shown
in the OOR file (View – Measurement Data – Out Of Range Data). The
min and max calibration points are given in the RID file, and in this case it
should be sufficient to go directly to ‘Edit – Reconvert Definition – Data
Definition’, and choose ‘RID values’ under ‘Out of range decimal values
settings’. Data is then reconverted by choosing ‘File – Reconvert Data’.
You can find more about reconverting in chapter 10.

The user can also define the ranges. Choose the Settings menu, Out Of
Range - UV and DV definition command. A dialog box appears:
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Figure 8.8 Set TD Out Of Range (OOR) Parameters

Decimal Values
Decimal Values (DV) are raw measurements, sometimes referred to as
binary data. The decimal value is between 0 and 4095, which is the range
for the 12 bit AD converter. The decimal values are the recorder’s
calibration range. The user should not define the decimal value range,
unless he has obtained these values for that particular recorder from Star-
Oddi.

Unit Values
The decimal values are converted to Unit Values (UV), for example a
decimal value of 2000 could give 20°C. The user can select a specified
range for temperature and pressure. If unit values in the data are outside
the measurement calibration range of the recorder, the user has the
option to set a max and min range for these unit values. After selecting the
unit value ranges and pressing the OK button, the following window
appears:
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Figure 8.9 Out Of Range (OOR) Correction

If no values have been selected for the Decimal Value (DV), no correction
should be selected. If Unit Values (UV) ranges were specified, the user
has the option to change the out of range measurements to the last value
that was recorded before the out of range measurement was recorded, or
have it according to the max/min unit value as specified earlier. In this
case the software will know if the value is under the minimum or maximum
limit. After the correction has been made, the data needs to be
reconverted under File – Reconvert Data, and data will be changed
accordingly.

8.8 Time Synchronize Data (TSD)

Choose the Settings menu, TSD definition command. A dialog box
appears:
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Figure 8.10 Time Synchronous Data Settings

If the user wants to time synchronize two or more data files, it is possible
to select three options: 1 hour, 10 minutes, or 5 minutes. The restriction is
that the sampling interval selected must be greater than the initial interval,
and it must also be dividable by the initial interval. For example, if the initial
interval was 15 minutes, only the 1 hour option can be selected for time
synchronous.

If the ‘Include empty cells’ is enabled, the data tables will be empty for
those measurements in the original file that are not to be shown.

If the user wants to activate this feature, the ‘Make TSD file when
converting DAD-DAT’ must be enabled. For changing the current
measurement file with one of the three intervals, the data must be
reconverted by ‘File – Reconvert Data’.

8.9 Rate Of Change (ROC)

This new feature gives the user a chance to see how fast the signal is
changing, i.e. the estimated velocity of the signal. This applies to all
measured parameters. The ROC is calculated via a two point numerical
differentiation:
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ROC= (P2-P2)/(t2-t1)
P: Parameter expressed in a user defined unit
t: Time (hour, minute or second)

The way the ROC is set up and viewed is very similar to the TSD.
Under ‘Settings\ROC’ the ROC options can be set:

Figure 8.11 ROC Definition

The ROC is only computed when a DAD->DAT conversion is performed,
and when the user wishes. The time units are selectable as hour, minute
or seconds. For small changes it can be convenient to express the ROC
as a milli (10-3) unit. For example if the depth is in meters (m) then
millimeters are expressed as (mm).

The ROC can be viewed as a trend under ‘View\Data Trend and
Table\Rate Of Change (ROC)’ or as tabulated data via
‘View\Measurement Data\Rate Of Change’.
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8.10 Chart

1. Title
Click the title name to change the title of the chart. A dialog box appears:

Figure 8.12 Chart Title Dialog Box

The chart is automatically assigned the data file number as a chart title. To
change the chart title, enter a new text string and press the OK button.

2. Time Axis
To change the time scale of the chart, click on the X axis scale. A dialog
box appears:

Figure 8.13 X-Axis Settings Dialog Box
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By disabling the Automatic option, the minimum and maximum time values
become active. By clicking on the Change buttons for the maximum and
minimum values, the time range can be specified. By enabling the
Automatic option, the measurement time will go back to the initial range.

3. Value Axis
To change the scale settings for the value axis, double click on either of
the Y axis scale, for temperature or depth. A dialog box appears:

Figure 8.14 Y-Axis Settings Dialog Box

By disabling the Automatic option, the minimum and maximum
measurement values become active. By clicking on the Change buttons
for the maximum and minimum values, the temperature (or depth) range to
be shown on the chart can be specified. By enabling the Automatic
option, the measurements will go back to the initial range.

8.11 Chart Editor

The Chart Edit button (on every graph) gives access to the Chart Editor, a
multi-option menu, now with a Tree View interface, as can be seen in
figure 8.15.
There are five main branches on the tree:
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1. Series
2. Chart
3. Data
4. Tools
5. Export

The tree menu gives access to the same features as the tab menu
described in the user’s manual. Most of the changes invoked are viewable
immediately.
All format and style changes made to the chart, are lost if the data are
viewed again or “Reconverted”, as the *.DAD and the *.DAT file are not
affected by changes made to the chart or the database.

1. Series
The Series window offers the same features as the “Active Series List”
button.

Figure 8.15 Chart Editor

When a particular series is selected, like the Temperature series for
example, a two tab menu is revealed, as seen in fig. 8.16, where the user
can “format” each series, and set “points” in the graph. The tab “Point”
offers visibility to points as the “Data Point Marker” button on the graph,
plus formatting of the points.
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Figure 8.16 Format Series

2. Chart
The chart branch has six sub branches:

2.1 Axis
2.2 Titles
2.3 Legend
2.4 Panel
2.5 Paging
2.6 Walls

2.1 Axis
There are 8 axes in a normal SeaStar chart, the number in use depends
on the recorder type. The Left Axis and Custom 1 axis are always in use,
the latter is reserved for the timeline.
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Figure 8.17 Axis Formatting

Figure 8.17 shows a six tab Axis menu. There are numerous options,
some of which can drastically change the behavior of the graph. The
Minimum and Maximum tabs give options similar to the menu offered
when clicking an axis on the graph, the ticks tab gives access to enable
and disable gridlines, just as in the “Horizontal gridline” and “Vertical
gridline” buttons in the graph.

2.2 Titles
The Titles menu shown in figure 8.18, gives access to 4 tiles, each title a
multi line text window, which can be positioned anywhere on the chart.
There are multiple formatting options, six tabs, for each title.
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Figure 8.18 Titles Menu

2.3 Legend
The legend menu (see figure 8.19) gives the user an option of showing a
series legend.
The 8 tab menu gives options in styling positioning and formatting the
legend.

Figure 8.19 Legend Menu
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2.4 Panel
The Panel menu (see figure 8.20) offers panel format options. Images,
pictures and icons can be imported onto the panel as a back image.

Figure 8.20 Panel Menu

2.5 Paging
With the Paging menu, shown in figure 8.22, the data series can be
chopped into pages, with a user defined number of points per page. Only
one page is shown at a time, and the user can scroll through the pages
via the page buttons, that appear (are enabled) on the chart to the right of
the Edit Chart button, when paging is selected.
Paging can be useful for viewing distinct time periods, one at a time, days
or hours for example. No offset is offered and sampling periods and start
time can limit the usefulness of this option.

Figure 8.21 Paging Menu
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2.6 Walls

Figure 8.22 Walls Menu

The walls menu, as seen in figure 8.22, gives access to configuration of
four walls, but as SeaStar charts are default defined as 2D, only the
“Back” wall is visible.
The Walls menu, has similar options as the Panel menu, when defining a
pattern, via the “Pattern…” button, as seen in figure 8.22, an image can
be imported and placed on the wall. In fact, as the Back Wall lies “on top”
off the panel, a pattern or an image can enhance an image on the panel,
or the image on the panel can be seen through the wall with the
Transparency option.

3. Data
In the data menu, seen in Figure 8.23, gives the user access to the
database, upon which the chart rests. Here text labels can be set to each
measurement point. Changes can be made to the time and measurement
values. Changes made to the data, are included when the data is
exported, but if the data are viewed again or “Reconverted” all changes
are lost, as the *.DAD and the *.DAT file are not affected by changes
made to the database.
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Figure 8.23 Data Menu

4. Tools
Under 'Tools' you will find several options to customize the setting of the
cursor and the appearance of the graph, such as page numbering, font,
font size etc. To active/deactivate the chosen setting check/uncheck the
'Active' box on top of the first page of this menu.

Figure 8.24 First Page of Tools Menu



User Manual SeaStar Graphic Supporting Software

@2010 Star-Oddi. All Rights Reserved Page 63

5. Export

Figure 8.25 Export Menu: Picture

Under the Export menu, three tabs offer as many menus for saving data
as:

5.1 Pictures
5.2 Native (data)
5.3 Data (file)

5.1 Pictures
Figure 8.25 shows options when saving the chart as a picture to a file, or
copy the picture to the clipboard. There are seven format possibilities.

 Metafile
 Bitmap
 JPEG
 GIF
 PDF
 VML
 SVG
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5.2 Native
The Native menu, see figure 8.26, data is saved as “Native” *.tee chart
files. Import of these files is not supported in SeaStar at the moment.

Figure 8.26 Export Menu: Native

5.3 Data
Data can be exported to files in four formats, see figure 8.27.

 Text file (.txt)
 XML (.xml)
 HTML (.hml)
 Excel (.xls)

Figure 8.27 Export Menu: Data
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There are four Include options:

1. Point Index
The point index is the same as the measurement number, but offset
by -1, as it starts in 0 instead of 1.

2. Point Labels
If the user has added text labels to points in the DATA menu, these
can be included.

3. Header
The same headers as are in the DATA menu.

4. Point Colors
This option is not relevant in SeaStar.

Another method for exporting is to use the Alt+PrintScreen keyboard
buttons to copy an image of the SeaStar window to the clipboard,
thereafter to paste it to another Windows application. When a dialog box
is open, then only that frame is copied to the clipboard.
To copy a part of a data file, for example from a DAT file, then highlight the
part you want to copy and use the Ctrl+C keyboard buttons to copy the
data snippet to the clipboard. Then use the paste-option in another
Windows application to transfer the data from the clipboard.

Figure 8.28 Highlighted Text to be copied
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8.12 Timeline

The timeline is a graphical viewing aide. Every time a file is loaded for
trending, an extra time value is calculated for every measurement point.
These time values form the Timeline. The Timeline is an extra series that
follows the rules of the other measurement series. When the graph first
appears, the Timeline is inactive.
By selecting the Timeline in the Series List (see fig. 8.29), the Timeline
becomes visible as shown in figure 8.30.

Figure 8.29 Timeline Selection

Figure 8.30 Timeline on a graph showing “Day of the Year”
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The Timeline is defined under Settings\Preferences\Timeline.
There are several options for the Timeline, as can be seen in fig. 8.31.

Figure 8.31 Timeline Options

There is no need to reconvert the data, as every time a data file is loaded,
the Timeline is calculated in accordance with Timeline settings. The
Timeline is not a part of the *:DAT or the *.TSD files, but if the data is
exported (see the Export section), then the Timeline, if selected, will be
included. Thus, the Timeline can also be used for statistical purposes.

8.13 Templates

There are two scenarios where templates come in handy:

1. When many recorders are programmed with the same settings
(multi mode), and circumstances are in a way that the user cannot
complete the setup of all the recorders in one session, and he has
to exit SeaStar (to continue later).

2. When the user wants to reuse, partly or completely, presumably a
complex and/or lengthy measurement setting.
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Figure 8.32 Template Options in Edit\New Measurement Sequence

Saving a Template
The user can now, when editing New Measurement Settings (NMS), save
his work by enabling “Save this NMS as a Template (file)” option (see fig.
8.32), before acknowledging OK from the Edit NMS menu. Having
selected this option and the NMS are OK, then the user has an option to
write a description for the template (see fig. 8.33). Canceling this option
cancels the ‘save template’ operation. The template is an INI file and
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saved in the SeaStar\NMS directory. The name of the file is
MST<date><type letter>time<Interval mode>.INI.

Figure 8.33 Saving NMS as a Template

Using a Template
Templates can be retrieved at a later time to be used directly or modified.
The list of templates is kept in the SeaStar\templets.ini file.
As can be seen in fig. 8.32 there are three buttons in the Edit NMS
window, the top button is used for retrieving a template.
As can be seen in fig. 8.34, templates are selected via template name or
description. Parallel to selecting a template, descriptions can be edited
and eventually templates deleted.
The recorder type and interval type, which the template was based on, are
visible for each template.

Figure 8.34 Template Selection

Templates can be used across recorder type boundaries and interval
types.
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Things to keep in mind when selecting a template are:

 Single interval templates converted to a multiple interval NMS. All
seven intervals are the same.

 Multiple interval templates converted to a single interval NMS, set
the interval as interval one.

 Start time in the past is not allowed as will be apparent when exiting
the Edit NMS window.

 Some recorder types are less compatible than others, an example
of that is a DST milli template converted to a DST GPS NMS.

After selecting a template the user is returned to the edit window. If the
selection is not as what the user expected the “Previous” button will
return the previous setting.

The user has one more option to quickly set up the NMS. The button in
fig. 1, marked “Use Default”, will return default NMS settings. The button
can have four descriptions and return four different settings depending on
the status of recorder and measurement selection.

1. Use Default: No recorder selected.
2. Use Recorder: Recorder selected but not a measurement

sequence.
3. Use Sequence: Measurement sequence selected.
4. Use Online: Recorder is on-line.
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9.Multiple Intervals

SeaStar has the option for setting up more than one sampling interval
within a measurement sequence. Reasons for wanting multiple intervals
can be to save memory, but still be able to have frequent measurements
in between. This may be the case with fish tagging, when frequent
recording is wanted in a specific period in the fish life cycle. If you want to
run on a single interval the whole recording period, this option is not
selected.

By choosing Multiple Intervals (under Settings-Preferences-
Measurement Intervals), multiple interval setup is activated. Thereafter,
choose the Edit menu and New Measurement Sequence Definition
command. A dialog box seen on figure 9.1 appears.Start time
The user defines the date and time when recordings should start.

9.1 Measurement Interval

Set primary measurement interval time (hours-minutes-seconds). If the
GPS is not enabled as a primary measurement, then temperature and
depth becomes primary. In this case the GPS listening becomes the
secondary interval, and needs to be defined. The GPS interval is defined
as how often the tag should listen for an acoustic signal along with the
temperature and depth recordings.

For example, if the interval is set as 6, then the tag will listen for a GPS
code (acoustic signal), every sixth time when temperature and depth
measurements are recorded. But if the secondary interval is set to 0, the
tag will never listen for GPS codes. Up to 7 different sampling intervals
can be selected. If for example two intervals will be used, then only two
intervals need to be filled out. If seconds are used as sampling interval,
the multiple of the sampling interval and the number of measurements
must be dividable by 60.

9.2 Setup Mode

If the user wants to program several recorders with the same sampling
interval and start time, it is recommended to select Multi mode. By
choosing Multi mode, the settings are fixed; giving each recorder



User Manual SeaStar Graphic Supporting Software

@2010 Star-Oddi. All Rights Reserved Page 72

connected to thereafter, the same settings. The recorders connected to
following the first recorder, automatically get the same settings as the first
recorder. This saves time in the programming process.

9.3 Number of Measurements N1-N7

The user defines the number of measurements to be recorded within each
sampling interval. A value from 1 to 60000 can be set. Please note that
an inital measurement is taken at the defined ‘start time’. This initial
recording is not counted as a measurement for the ‘Interval 1’ number of
measurments. For example if the recorder should measure every hour
from midnight to ten o’clock (00:00 – 10:00), then the number of
measurements defined should be 10. Please note that only this one
measurement at the ‘start time’ does not count as a measurement for the
intervals. In this case, the first measurement counted for the ‘Interval 1’ is
at 01:00, and the last measurement is at 10:00, and then it shifts to
another interval.

Figure 9.1 Set New Measurement Sequence (with multiple intervals)
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After taking one measurement at the ‘start time’, the recorder will start on
the first interval in the sequence and take the number of measurements as
defined. After taking the measurements on the first interval, it will
automatically shift to the next interval etc. The sampling intervals and
number of measurements will recycle until memory is full, or until
connection is made with the recorder through a PC computer.

9.4 GPS as Primary

If this option is enabled, the sampling interval defined is valid for the GPS
listening. If this option is disabled, the sampling interval is for temperature
and depth recordings (TD as primary).

9.5 Secondary Interval

Depending on if GPS is selected as primary or not, either GPS or TD
(Temp-Depth) becomes a secondary parameter. This is to define how
often the secondary parameter should be recorded along with the primary
parameter. For example if it is set to 1, it will always take the primary and
secondary measurements at the same time (same interval for GPS and
TD), and if it is set to 2, the secondary parameter will sample every
second time the when the primary parameter is sampled etc.

9.6 After a GOOD GPS Code Perform

The special TD interval can be defined as to execute ‘never’, ‘only once’ or
‘always’ upon a good GPS code recording. Also, after a good GPS
measurement, the tag can be programmed to ‘continue as before, ‘swap
primary and secondary’ or ‘cancel further GPS measurements’.

9.7 A good GPS Measurement is Defined as

The DST GPS tries to record up to 6 codes when signal is received. A
good GPS code can be defined as receiving the same code (SPOK)
once, twice or three times. If for example two of same code is received in
a row, the probability of erroneously decoded position is 1 against 10000
(Pe<1e-4).
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9.8 Set STDI (Special Temp Depth Interval)

Special Temp Depth Interval (STDI) needs to be defined. The number of
measurements taken should also be defined. This gives an option to shift
into a different temperature and depth recording interval after receiving a
good GPS code.

9.9 Sequence 1-14

The interval sequence must be filled out. As shown in figure 10.1, the
user selects to use intervals 1-6 for the recordings. Another example:
If two of the first sampling intervals are used, the sequence should be 1,
2, 1, 2 etc., meaning that the recordings shift between the first and the
second intervals, recording the defined number of measurement for the
first interval, and then shifting to the second interval taking the number of
measurements defined. The shifting between the intervals repeats until
memory is full, or until connection is made through a PC computer.

9.10 Primary Receive Code Format

This should be synchronized with how the FPS is programmed. Global is
only used when the boat crosses the hemisphere, FPS-1 (610 m
resolution) if the boat crosses a quadrant, FPS-2 (70 m resolution) when
boat is within the same quadrant. If the FPS is at fixed location the FPS-ID
should be enabled.

For Initial Position the longitude and latitude at the location should be
defined.

After the settings have been selected, press the OK button.

The Use Template can be used if older definitions have been saved by
enabling the ‘Save this NMS as a template (file)’. That way it’s possible to
get templates that have been set up in the past. With the Use Sequence
button it is possible to get same settings as from other recorders, by
browsing for their serial no. By hitting the Previous button the settings go
back to previous, before changes were made.
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10. Reconvert Data

In SeaStar you have the option of reconverting data that has already been
retrieved. After re-defining parameters, the data is reconverted by ‘File –
Reconvert Data’. The main reasons for reconverting data are:

 Shift pressure/depth values according to a reference meter, to
increase accuracy.

 Adjust measurements that are outside calibration range.
 Incorrect PC-time at measurement start time.
 Need for temperature or pressure/depth unit alteration.
 Need for data file format alteration.

10.1Data Reconversion Definition

Under the Edit menu and Reconvert Definition, choose the Data
Definition command, and the following dialog box appears:

Figure 10.1 Reconvert Data Definition
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Set Reconversion Measurement Sequence Start-Time
If the user notes from retrieved data that the PC date and clock were
incorrect when measurements were started, it is possible here to specify
a new start date and start time.

In Reconversion use Measurement Intervals from
The measurement interval is either the interval settings as shown in the
measurement (MID) file, or if that interval is incorrect, a new and correct
sampling interval is specified in the ‘New Measurement Sequence
Definition’ command in the ‘Edit’ menu.

In Reconversion use Constants from
The user can choose to use calibration constants from:

 MID file. This option should normally be selected, as it contains
information on the constants from the measurement sequence.

 RID file. The recorder information file contains the same calibration
constants as the MID file, except if it has been re-calibrated. If it has
been re-calibrated, and the user wants to use the new constants on
older measurements, the RID option should be selected.

 RBD file. This option rarely needs to be selected. If the constants
from the MID and RID file are corrupt, the user should contact Star-
Oddi for an RBD file.

Convert Number of Data
The user can reconvert all the data in the last measurement sequence, or
define the number of measurements to be reconverted. The user has the
option to define what measurement range should be reconverted (for
example to exclude data points when the recorder was above water).

Time Linear Adjustment
The real time clock inside the DST has an accuracy of approximately +/-
1 minute per month. This slight variation might accumulate over time and
influence the measurement results. To correct the gradual time shift first
check „linear adjustment time“ then type in the time offset value and the
length of the measuring period.
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Out of Range Decimal Value Settings
Measurements that are outside the calibration range are inaccurate, and
may give erroneous results. The out of range (OOR) measurements can
be seen in the OOR file. The user has the following decimal value out of
range detection options when reconverting:

 Full scale (no boundaries). This means that literally no ‘out of
range’ detection will be made.

 User definition. With this selection the range definition under
‘Settings - Out Of Range - DV definition’ will be used. This option is
selected when the decimal values (DV) are not available in the RID
file. This would normally require the user to contact Star-Oddi for
the decimal values.

 RID values. The calibration decimal range is given in the RID file.
This is the default option and should normally be selected.

If an RBD file exists in the \Seastar\RBD folder, then SeaStar recognizes
this file as a primary source for DV calibration range. In this case, the
fourth option appears and is set as default.

10.2 Temperature Definition

Under the Edit menu and Reconvert Definition, choose the Temperature
Definition command, and the following dialog box appears:

Figure 10.2 Temperature Offset Correction Menu
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Offset Adjustment
When recorders are used over a long period of time, the temperature
measurements can start to deviate from correct values.
When checking older recorders, it has come apparent that the error in the
measurements is mainly due to an offset. Some users feel they can
benefit from an offset correction option in SeaStar, for example when a
recorder has been in the water for a long time and is later tested to show
an offset. The offset is defined in m°C (1°C = 1000 m°C).

10.3 Pressure Definition

Under the Edit menu and Reconvert Definition, choose the Pressure
Definition command, and the following dialog box appears:

Figure 10.3 Pressure Reconvertion Definition
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Disable Temperature Correction in Pressure Calculation
In case the temperature sensor is malfunctioning in a way that it will
indicate very high temperature values, it will offset the pressure
calculation. An automatic temperature correction is set by default in
SeaStar. To turn off this feature, check the box next to „Disable
temperature correction in pressure calculation“.

Pressure Offset Adjustment
The user can increase accuracy of pressure/depth recordings by finding
an offset value, which is the difference between a recorder’s depth value
and a reference meter’s value. Once the offset point has been set in, the
data can be reconverted, and all pressure/depth recordings shifted
according to the value defined (in mbar).

In cases where a drift has occurred with the pressure recordings, the
pressure data can be corrected if the user has a known reference point
for correcting the data. To find the offset value, the recorder should be
deployed in water, at a known depth (preferably >2 m depth), or placed
along with an accurate reference depth meter, where a reference point
can be taken. Once the offset value has been found, the offset pressure
value is put in the window shown above. The offset value can either be
subtracted or added to the pressure values.

When using 9.81 as g, the coefficient for converting cm into mbar is
1.019, for example: 100 cm = 101.9 mbar.

If the ‘Use at next data retrieval for this recorder’ is enabled, the offset
value is fixed for that particular recorder, and future data uploads of the
recorder will use the offset value defined, for shifting the pressure data.
The offset value will apply only to that particular recorder, and other offset
values can be defined for other recorders.

Pressure Linear Adjustment
Aging of the pressure sensor can result in an offset of the measured
pressure values. To correct these offset values you can select a linear
pressure adjustment. Check „linear adjustment value“ and fill in the
pressure offset value (difference between expected value and real value at
the end of the recording period) and the length of the measuring period.
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Linear Estimation outside Calibration Range
The pressure sensor tolerates a significantly higher pressure than its
calibration range. If the recorder is exposed to higher pressures than its
calibration limit it will result in erroneous data. By choosing this option you
will receive more adjusted values. Please note that since these values are
outside of the calibration range an exact adjustment is not possible, this
feature is mainly for estimation purposes.

Depth Calculation
For converting the pressure units to depth, the standard for the
acceleration of gravity is 9.81 (1 bar = 1000 mbar = 9.81 m), but it can
optionally be set from 9.78 to 9.83, depending on the gravity in the
different areas of the world.

10.4 Single Spike Correction

To enable single spike correction choose Edit-Reconvert Definitions-
Temperature Definition and the following dialog box appears:

Figure 10.4 Single Spike Correction
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Check Use Single Spike Correction.

There are two variables, Time and Limit. The Limit defines how much
difference can be between two points over a defined Time.

If a point is outside the range, +/- the limit of adjacent points. That point is
then calculated as the average of the adjacent points.

This feature is also available for Pressure.

Units and Data File Format
Using the Settings menu and Preferences, you can change the format of
the measurement units and the data file.

Reconvert Data
For reconverting the data, the data file must be open. To reconvert, select
the File menu, and choose the Reconvert Data command. The data file is
reconverted and conversion data files are created (CIT, DAB, DAT). A
new chart file is opened.
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11. Recorder Modes

In this chapter, the three operational modes of DST GPS are described,
that is the PC Mode, Sleep Mode and Measurement Mode.

11.1PC Mode

If the recorder is in the correct position in the Communication Box, and by
choosing the Recorder menu and the Connect command, the recorder is
put into PC Mode. At the bottom of the SeaStar window, the text On-line
is displayed, indicating that the recorder is on-line and in PC Mode.

While in PC Mode, the recorder will remain in an active listening stage.
The communication protocol is a simple master/slave arrangement, in
which the recorder is the slave. The slave will perform every command the
PC issues, and after execution of a command, it will return to listening.
When the recorder is connected to the PC, it is powered by the PC, and
not taking energy from the battery inside the recorder.

11.2 Sleep Mode

The user receives the recorder in Sleep Mode, but it can easily be
awakened by the Connect command in the Recorder menu. If the
recorder is not set in Measurement Mode, it goes into Sleep Mode when
the recorder is removed from the Communication Box. When the recorder
is in this mode, less energy is depleted from the battery.

11.3 Measurement Mode

The recorder is put into Measurement Mode by choosing the Recorder
menu, and Start New Measurements Sequence. The recorder starts
recording measurements according to the start time (date/month/year)
and sampling interval (hours/min.) defined by the user.

When the memory is full, the recorder shifts automatically into Sleep
Mode. If the recorder is still in Measurement Mode upon connection
through a PC computer, it stops recording and is put into PC Mode.
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12. Memory Organization

Data is kept in an EEPROM memory and will not be lost if the battery fails
or expires. The memory of the recorder is organized as shown in the figure
below:

New recordings
Unused memory/
Old recordings

VV Data memory

Settings V

Figure 12.1 Data Memory Organization

When data is retrieved from the recorder, the following occurs:

1. The computer retrieves the data from the recorder and writes the
data to the computer’s hard drive.

2. The recorder has stopped recording, but still holds the recorded
data.

When new settings are sent to the recorder, the following will occur:

1. New settings are sent to the recorder.
2. The data memory pointer is reset to the beginning of the data

memory and starts to write over older recordings.

The organization of the memory is now as follows:

Unused memory/
Old recordings

VV Data memory

Settings V

Figure 12.2 Data Memory with New Settings
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13. GPS Measurements

Each time a GPS measurement is sheduled, the recorder will first try to
recieve 3 High Gain (HG) GPS codes and then 3 Low Gain (LG) GPS
codes. Depending on the conditions this can result in several GPS
measurement results (attempts), wich are directly reflected by numerous
Log Codes (LC) combinations. To ensure correct timing, the HG and LG
measurements are two independent measurement sequences, each
occupying one minute measurement.

13.1LC combinations

Log codes 0-18, are stand alone codes, wich consist of the code number
itself and the amplitude value of the signal. This is a 3 byte code.

Log codes 21, 22, 23 and 31, 32, 33 are the GPS measurements, plus a
start-pulse amplitude value and sampling values for the first sync-pulse
and the stop-pulse. This is a 9 byte code. There are 54 possible LC
combination, wich are listed below.

Possible LC
combinations
High Gain (HG):
0
1
2+LG
3
4+LG
21+5
21+6+LG
21+22+7
21+22+8+LG
21+22+23+LG

Low Gain (LG):
10
11
12
13
14
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31+15
31+16
31+32+17
31+32+18
31+32+33

Codes

No GPS Codes
LC (Log Code) combinations that will result in LC only, and no GPS
codes are:

0
1
3
2+ 10, 11, 12, 13, 14
4+ 10, 11, 12, 13, 14

HG (High Gain) only Codes
LC combinations that will result in HG codes alone, i.e. no LG GPS
measurements attemted, are.

0
1
3
21+5
21+22+7

All other codes involve LG measurements or measurement attempts, for
example:

21+22+23+10, 11, 12, 13, 14

If LG measurements are attempted or performed, the GPS measurements
operation will span two minutes.

Data Storage
The result of a GPS measuring attempt is stored in Eeprom memory. The
data space needed varies in size from 3 byte, single LC only, to 54 byte,
when 3HG and 3LG codes are received. There are 13 storage size
combinations. Thus estimating maximum possible number of
measurements is difficult. When GPS measurements are scheduled, the
memory requirements vary with the ratio of attempts and successful
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readings. If for example 3 high gain GPS measurements are successfully
taken every time temperature and depth measurements are taken, the
capacity is 3959 GPS measurements.
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14. Appendix

14.1Directories and Files

Directory Structure
The user can choose between SeaStar’s default data directory structure
(path) or define his own data path. As the SeaStar program is a multi
recorder type program, the directory structure branches from the directory
where SeaStar is positioned down to type directories, i.e. Starmon mini,
DST GPS etc. From there it branches again into recorder directories,
named after the serial numbers of the recorders, designed to hold data for
each individual recorder (data directory). All in all it is a three level
directory structure.

An example of this directory structure with DST GPS is:
C:\Seastar\ The installation directory (SeaStar.exe location)

C:\Seastar\DST GPS\ The type directory for DST GPS

C:\Seastar\DST GPS\G2018\ The directory for the G2018 recorder

When a new recorder type is selected in SeaStar (File – New Recorder
Type), the directory for that recorder type is created. When connecting to
a recorder for the first time, SeaStar creates the recorder directory,
named after the serial number of the recorder.

Information Files
SeaStar uses information files to store and retrieve settings. There are
two types of information files:
1) The type-INI files, (for example DSTg.ini for DST GPS).

The information type files are all in the installation directory, they
contain information on specific settings for each type. The type-INI files
are:
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StarmonT.ini Starmon mini
DSTm.ini DST milli
DSTr.ini DST milli recycle
DSTu.ini DST micro
DSTc.ini DST centi/centi-ex
DSTs.ini DST CTD
DSTg.ini DST GPS
DSTx.ini DST pitch & roll
DSTq.ini DST compass
DSTi.ini DST comp-tilt

2) The recorder-INI files, for example G2018.ini contains settings
information and data file positioning for the G2018 recorder. The
recorder-INI files are located in the appropriate type directory, i.e. all
the Gxxxx.INI files are in the ‘DST GPS’ directory.

Files Locations
As stated previously, the type-INI files are placed in the ‘Seastar’
directory, and the recorder-INI files are placed in the recorder type
directory. All other recorder and measurement related files created by
SeaStar, are placed in the appropriate recorder’s directory. For example:
C:\SeaStar\DST GPS\G2018\ is a directory for the G2018 recorder and
all files belonging to G2018 are placed there.

If the user whishes to use his own defined data path, for example
C:\Data\, then all the files for all the recorders, except for the INI files, are
placed there. If the user has enabled the “Create recorder directories” in
the user path definition, individual recorder directories, irrelative to type,
are created under the user defined path, for example: C:\DATA\G2018\
for the G2018 recorder. The G2018.ini file (located in the
C:\SeaStar\DST GPS\) contains the path to the C:\Data\G2018\
directory, and all files related to the G2018 will be placed in that
particular directory.

Browsing for a Recorder
When browsing for a new recorder from the ‘Select recorder’ under the
files menu, the default method is to find a recorder-INI file in the type
directory. The INI file will then point to the data directory (the recorder’s
directory). If the user has enabled the “Browse first in the user directory”
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in the user path definitions, the search starts in the user defined directory,
where a *.RID file must be selected.

Recorder Related Files
Every file that is recorder related has the following name format:

Cxxxx: The name is the serial no. of the recorder

Ext Description File type
RID Recorder information data Binary
RIT Recorder information text Text
RBD Recorder backup data Binary
RDD Recorder SNMS* download information data Binary
RDT Recorder SNMS* download information text Text

*SNMS: Start New Measurement Sequence

The recorder ID (RIT) can at a later time be opened, and the related
measurement data can be viewed, printed and reconverted. The RDD,
RDT and DIR are downloading information files, created when a new
measurement sequence is started.

Measurement Related Files
Every file that is specifically measurement related has the following name
format:

mmmGxxxx: The name is the measurement number + serial no.

Ext Description File type
MID Measurement information data Binary
MIT Measurement information text Text
MDD Measurement download information data Binary
MDT Measurement download information text Text
CIT Measurement conversion information text Text
DAD Measurement Data Binary file Binary
DAB Measurement Data Binary file Text
DAT Measurement Data Binary data Text

The MID, MIT and DAD files are created upon measurement data retrieval
from the recorder. The DAB, DAT and CIT files are created when
converting the data. The MDD and MDT are download information files
and created when a new measurement sequence is started.
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Data Files
Upon data retrieval, three main data files are created.

The *.DAD File
This file is the raw data source file. The data is in mixed binary form. The
user cannot access this file in the SeaStar program. When converting
these raw data into measurements, the *.MID file is needed. The result
from the conversion are two data files, the *.DAB and the *.DAT.

The *.DAB File
This file contains sequential binary representation of the data in columns.
The first column is the measurement number. The other columns contain
the measured parameters in a binary form.

The *.DAT File
This is the actual result file, where the measurements are converted to
their natural units and timed. This is a text file with columns. The first
column is the measurement number, the second column the date and the
time, depending on the set-up. The third column is the time or the first
measured parameter, depending on set-up. The following column(s)
contain the converted measured parameters with units and number of
decimals according to set-up. Number of parameters can range from 1-3,
and number of columns 3-6 accordingly.

Data Header
The *.DAT file contains a data header, which is a detailed description of
how the *.DAT file is configured. This feature is used by SeaStar when
graphically representing the data, and is practical if the user wants to
import the data into other applications or databases. Most of these
descriptive items are derived from the ‘Settings’ menu and the recorder
type definition in the ‘File’ menu.

Each header item is contained in one line, and all header lines start with a
# (bookmark) and a number. Then follows a description of the header
item, and then 1-4 directives, all separated by tabs. Eventually a comment
trails the directives, preceded by a ; (semicolon).
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14.2 Log Codes

The GPS log codes are divided into two sections, High Gain (HG) codes,
0-8, 21-23, and Low Gain (LG) codes ,10-18, 31-33.

No. Description
0: No power detection

No sound was heard.

1: Power detection, but no signal
There was power detection, but then nothing for 5 sec.

2: Power detection, but constant signal
There is power detection, but no detectable silence period (for 5

sec).

3: Signal detection, but no start pulse
There is power detection, and signal detection, i.e. detection of
pulses, but then the silence period has exceeded 7 sec. The
definition of the start pulse is a silent period that is at least 2 sec.
and no more than 5 sec.

4: Signal detection, 60 pulses but no start pulse
There is power detection, and 60 pulses have been detected, i.e., a
pulse is an ON signal followed 300 ms. later by silence (OFF).
None of the silences exceeded 2 sec.

5: No signal after first GPS code
After reading and storing the first High Gain (HG) GPS code, the
next frame appeared after less than 2 sec.

6: Frame collision after first GPS code
After reading the first code, the next frame (a signal) appeared less
than 2 sec later.

7: No signal after second GPS code
After reading and storing the second HG GPS code, the next frame
appeared after less than 2 sec.

8: Frame collision after second GPS code
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After reading the second HG GPS code, the next frame (a signal)
appeared less than 2 sec later.

10: Low Gain (LG) - No power detection
No sound was heard.

11: LG - Power detection, but no signal
There was power detection, but then nothing for 7 sec.

12: LG - Power detection, but constant signal
There is power detection but no detectable silence period (for 7

sec).

13: LG - Signal detection, but no start pulse
There is power detection, and detection of pulses, but then the
silence period has exceeded 7 sec. The definition of the start pulse
is a silent period that is at least 2 sec but not more than 5 sec.

14: LG - Signal detection, 60 pulses but no start pulse
There is power detection, and 60 pulses have been detected, i.e. a
pulse is an ON signal followed 300 ms. later by silence (OFF).
None of the silences exceeded 2 sec.

15: No signal after first LG code
After reading and storing the first LG GPS code, the next frame
appeared after less than 2 sec.

16: Frame collision after first LG Code
After reading the first LG GPS code the next frame (a signal)
appeared less than 2 sec later.

17: No signal after the second LG GPS code
After reading and storing the second LG GPS code, the next frame
appeared after less than 2 sec.

18: Frame collision after the second LG GPS Code
After reading the second LG GPS code the next frame (a signal)
appeared less than 2 sec later.

Note: Codes 1-18 are error codes.
Codes 0, 1, 3 are abort codes. The LG sequence is not performed.
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After code 2 and 4 the LG sequence is initiated.
Codes 10-18 will end/abort the LG sequence.

21: First HG GPS Code
Start pulse detected, and first HG GPS code was read and stored.

22: Second HG GPS Code
Second HG GPS code was read and stored.

23: Third HG GPS Code
Third HG GPS code was read and stored.

After code 21+22+23, 21+6, 21+22+8 the LG sequence is
initiated

31: 1. LG GPS Code
First LG GPS code was read and stored.

32: 2. LG GPS Code
Second LG GPS code was read and stored.

33: 3. LG GPS Code
Third LG GPS code was read and stored.

Error Code (EC):
When the GPS codes are translated, three checks are made on the
GPS code, which may result in the following error codes (EC).
0: OK Singular check OK
1: SyncErr One or more of the sync bits are faulty
2: StopErr There is a stop bit error
3: ParErr There is a parity bit error

For numerous errors the ECs are combined to read:

12: for 1 and 2
13: for 1 and 3
23: for 2 and 3

123: for all three
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